
 

Code Reader Setting Guide

-CF26-SR
-CF26-LR
-CF37-SR
-CF37-LR

This product is designed and manufactured by Cognex Corporation. 
*Note that the warranty and general specifications of this product 
  differ from that of programmable controller products.





SAFETY PRECAUTIONS
(Read these precautions before using this product.)
Before using this product, please read this manual and the relevant manuals carefully and pay full attention to safety to handle 
the product correctly.
The precautions given in this manual are concerned with this product only. For the safety precautions for other modules, refer 
to their respective user's manuals.
In this manual, the safety precautions are classified into two levels: " WARNING" and " CAUTION".

Under some circumstances, failure to observe the precautions given under " CAUTION" may lead to serious 
consequences.
Observe the precautions of both levels because they are important for personal and system safety.
Make sure that the end users read this manual and then keep the manual in a safe place for future reference.

[Installation Precautions]

[Security Precautions]

[Installation Precautions]

WARNING
 Before handling the code reader, touch a conducting object such as a grounded metal to discharge 

the static electricity from the human body. Wearing a grounded antistatic wrist strap is recommended. 
Failure to discharge the static electricity may cause the code reader to fail or malfunction.

 Be sure to install an I/O connector module to a main module. If not installed, dust or water-proof 
performance may not be obtained.

WARNING
 To maintain the security (confidentiality, integrity, and availability) of the programmable controller and 

the system against unauthorized access, denial-of-service (DoS) attacks, computer viruses, and other 
cyberattacks from external devices via the network, take appropriate measures such as firewalls, 
virtual private networks (VPNs), and antivirus solutions.

CAUTION
 IP protection rating is guaranteed only when all the connectors are connected with cables or sealed 

with sealing caps.
 The cable is designed to connect with its key aligned with the keyway of the connector on the code 

reader. Do not force the connections or damage may occur.

WARNING Indicates that incorrect handling may cause hazardous conditions, resulting in 
death or severe injury. 

CAUTION Indicates that incorrect handling may cause hazardous conditions, resulting in 
minor or moderate injury or property damage.
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[Wiring Precautions]

[Startup and Maintenance Precautions]

[Disposal Precautions]

PRECAUTIONS FOR USE
Observe the following precautions when installing and operating the code reader, to reduce the risk of injury or equipment 
damage:
 • This device requires the use of an LPS or NEC class 2 power supply.
 • To reduce the risk of damage or malfunction due to over-voltage, line noise, electrostatic discharge (ESD), power surges, or 

other irregularities in the power supply, route all cables away from high-voltage power sources.
 • A code reader does not contain user-serviceable parts. Do not make electrical or mechanical modifications to a code 

reader. 
Unauthorized modifications may void your warranty.

 • Changes or modifications not expressly approved by the party responsible for regulatory compliance could void the user's 
authority to operate the equipment.

 • If the bend radius or service loop is smaller than 10 times of the cable diameter, the cable may cause cable shielding 
degradation, cable damage, or wear out in a short period. The bend radius must begin at least 152.4 mm from the 
connector.

 • Use this device in accordance with this manual.

CAUTION
 Use only 24 VDC and observe the indicated polarity. Otherwise, fire or damage may result.

CAUTION
 Do not clean the code reader with highly irritating or corrosive solvent such as caustic alkali solution, 

methyl ethyl ketone (MEK), and gasoline. Doing so may cause a fault.

CAUTION
 When disposing of this product, treat it as industrial waste.



CONDITIONS OF USE FOR THE PRODUCT
(1) This code reader shall be used in conditions;

i) where any problem, fault or failure occurring in the code reader, if any, shall not lead to any major or serious accident;  
and 
ii) where the backup and fail-safe function are systematically or automatically provided outside of the code reader for 
the case of any problem, fault or failure occurring in the code reader.

(2) This code reader has been designed and manufactured for the purpose of being used in general industries.
MITSUBISHI ELECTRIC SHALL HAVE NO RESPONSIBILITY OR LIABILITY (INCLUDING, BUT NOT LIMITED TO 
ANY AND ALL RESPONSIBILITY OR LIABILITY BASED ON CONTRACT, WARRANTY, TORT, PRODUCT 
LIABILITY) FOR ANY INJURY OR DEATH TO PERSONS OR LOSS OR DAMAGE TO PROPERTY CAUSED BY THIS 
CODE READER THAT ARE OPERATED OR USED IN APPLICATION NOT INTENDED OR EXCLUDED BY 
INSTRUCTIONS, PRECAUTIONS, OR WARNING CONTAINED IN MITSUBISHI ELECTRIC USER'S, INSTRUCTION 
AND/OR SAFETY MANUALS, TECHNICAL BULLETINS AND GUIDELINES FOR the CODE READER. 
("Prohibited Application")
Prohibited Applications include, but not limited to, the use of the code reader in;
• Nuclear Power Plants and any other power plants operated by Power companies, and/or any other cases in which the 

public could be affected if any problem or fault occurs in the code reader.
• Railway companies or Public service purposes, and/or any other cases in which establishment of a special quality 

assurance system is required by the Purchaser or End User.
• Aircraft or Aerospace, Medical applications, Train equipment, transport equipment such as Elevator and Escalator, 

Incineration and Fuel devices, Vehicles, Manned transportation, Equipment for Recreation and Amusement, and 
Safety devices, handling of Nuclear or Hazardous Materials or Chemicals, Mining and Drilling, and/or other 
applications where there is a significant risk of injury to the public or property.

Notwithstanding the above restrictions, Mitsubishi Electric may in its sole discretion, authorize use of the code reader in 
one or more of the Prohibited Applications, provided that the usage of the code reader is limited only for the specific 
applications agreed to by Mitsubishi Electric and provided further that no special quality assurance or fail-safe, 
redundant or other safety features which exceed the general specifications of the code readers are required. For details, 
please contact the Mitsubishi Electric representative in your region.

(3) Mitsubishi Electric shall have no responsibility or liability for any problems involving code reader trouble and system 
trouble caused by DoS attacks, unauthorized access, computer viruses, and other cyberattacks.
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INTRODUCTION
Thank you for purchasing the Mitsubishi Electric FA sensor, MELSENSOR.
This manual describes the basic operations of DataMan Setup Tool for MELSENSOR.
For detailed description, use [Q & A] or [Help] on the menu of DataMan Setup Tool for MELSENSOR.
Before using the product, please read this manual and relevant manuals carefully, and develop familiarity with the functions 
and performance of the code reader to handle the product correctly.
Note that the menu names and operating procedures may differ depending on an operating system in use and its version. 
When reading this manual, replace the names and procedures with the applicable ones as necessary.
Please make sure that the end users read this manual.
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RELEVANT MANUALS

e-Manual refers to the Mitsubishi Electric FA electronic book manuals that can be browsed using a dedicated 
tool.
e-Manual has the following features:
 • Required information can be cross-searched in multiple manuals.
 • Other manuals can be accessed from the links in the manual.
 • Hardware specifications of each part can be found from the product figures.
 • Pages that users often browse can be bookmarked.
 • Sample programs can be copied to an engineering tool.

Manual name [Manual number] Description Available form
Code Reader Setting Guide
[BCN-P5999-1258] (this manual)

Basic operations of DataMan Setup Tool for MELSENSOR e-Manual
PDF

Code Reader CF26 User's Manual
[SH-082092ENG]

Functions, installation methods, system configuration, and required hardware 
components etc. of a code reader CF26

e-Manual
PDF

Code Reader CF37 User's Manual
[SH-082325ENG]

Functions, installation methods, system configuration, and required hardware 
components etc. of a code reader CF37

e-Manual
PDF

Code Reader Connection Guide
[BCN-P5999-1074]

Procedures for connecting a code reader to a MELSEC programmable 
controller to control a code reader through a CC-Link IE Field Network Basic 
connection, an SLMP connection, an RS-232 connection or an I/O connection

e-Manual
PDF
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1 OVERVIEW

1.1 Overview of DataMan Setup Tool for MELSENSOR
DataMan Setup Tool for MELSENSOR (hereafter referred to as SetupTool) sets the operation of MELSENSOR Code Reader 
CF Series. Each process for connecting, adjusting, and testing MELSENSOR Code Reader CF Series can be set easily in 
accordance with application steps.
In this manual, a CF26 is used as an example to explain each setting.

Target code readers of SetupTool
Name Model name
CF26 CF26-SR, CF26-LR

CF37 CF37-SR, CF37-LR
1  OVERVIEW
1.1  Overview of DataMan Setup Tool for MELSENSOR
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2 SetupTool INSTALLATION

2.1 Installation
Operating environment

Installation procedure
1. Download the installer of SetupTool from the Mitsubishi Electric FA website.
www.MitsubishiElectric.co.jp/fa

2. Close all running applications.

3. Run the obtained installer.

4. Select or enter the necessary information according to the instructions shown in the screen.

Item Description
Operating system (English version) Microsoft Windows 7 Professional, Service Pack 1 (32-bit, 64-bit)

Microsoft Windows 10 Professional (32-bit, 64-bit)

Available hard disk capacity 2 GB or more

Ethernet 100 Mbps
(1 Gbps recommended)
2  SetupTool INSTALLATION
2.1  Installation
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MEMO
2  SetupTool INSTALLATION
2.1  Installation 11
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3 CODE READER SETUP FLOW CHART

3.1 Setup Flow Chart
1. Wiring
Wire a code reader by referring to 'Chapter 4 Section 4.1 Configuration and Wiring 
of CF26/CF37 Series.' When communicating and controlling the code reader with 
industrial protocols such as SLMP, only power lines need to be wired.

2. Connection
Connect to a personal computer by referring to 'Chapter 5 CONNECTING with 
SetupTool.'

3. Installation
Install the code reader by referring to 'Chapter 7 Section 7.1 Installing a Code 
Reader.' (When pre-assessment and tests are executed, install the code reader in 
accordance with the results.) The distance from the code reader to an inspection 
target as well as the direction and angle of the code reader may affect the read rate 
significantly.

4. Tune
Tune the code reader by referring to 'Chapter 7 Section 7.2 Settings in Tune,' 
'Appendix 4 Supplemental Remarks for Tuning (1),' or 'Appendix 5 Supplemental 
Remarks for Tuning (2).' Mainly, auto-tuning can be executed by configuring 
'Optimize Image'  'Tune.' In some cases, 'Exposure,' 'Gain,' 'Lightening pattern,' 
and 'Image Filter' need to be adjusted manually.

5. Reading test
A code is read and a reading test is performed by pressing the [Trigger] icon. The 
test can also be performed by enabling 'Test Mode'.

6. Other settings
Other settings such as a trigger type, multi-codes, data format, code quality, and 
communication are configured by referring to 'Chapter 8 Application Steps' as 
necessary.

7. Operation test
A code is read and the operation test of the whole code reader settings is performed 
by a command from the [Trigger] icon or the external device.

(1)Wiring

(2)Connection

(3)Installation

(4)Tune

(5)Reading test

(6)Other settings

(7)Operation test
3  CODE READER SETUP FLOW CHART
3.1  Setup Flow Chart
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4 CONFIGURATIONS

4.1 Configuration and Wiring of CF26/CF37 Series 

Configuration

For details on the Ethernet cables (COGNEX products) and breakout cables (COGNEX products), refer to the user's manual 
for a code reader.

(CCB-84901-2001-**)

(CCB-PWRIO-**)

(CCB-M12X12FS-05)CF37-SR CF37-LR

CF26-SR

CF26-LR

(CCB-84901-2002-**)

Switching hub

Ethernet cable

Breakout cable (COGNEX products)

24 VDC

power supply

24 VDC

power supply

red

black

brown

blue

Code Reader Ethernet cable (COGNEX products) Personal computer

or

or
or
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5 CONNECTING with SetupTool
Set an IP address for a personal computer and the code reader that matches each other to connect the code reader and 
SetupTool.
An IP address is an ID number assigned to a device to be communicated with Ethernet. To establish communication with 
devices, an IP address that matches with the IP address of each device needs to be set.
Set the IP address in accordance with the use situation.
 • For using the code reader in a system, the IP address must be matched with that of a device to be communicated (mainly a 

programmable controller). Select "Use Static IP Address" for the code reader and "Use the following IP address" for the 
personal computer, and set the respective IP address according to a device to be communicated.

 • For using the code reader by connecting only to the personal computer, the IP address of the code reader must be matched 
with that of the personal computer.

 • When "Obtain an IP address automatically" is selected for the personal computer, select "Use DHCP Server" for the code 
reader.

 • When "Use the following IP address" is selected for the personal computer, select "Use Static IP Address" for the code 
reader and set the code reader IP address that matches with the personal computer.

 • For an IP address to be set when "Use Static IP Address" or "Use the following IP address" is selected, the rightmost set of 
numbers in the IP address must not be duplicated with that of the other devices. The setting of a subnet mask must be the 
same for the entire devices.

(An IP address setting example)

In this manual, the IP addresses shown above are used.

Setting item Personal computer Code reader
IP address 192.168.3.3 192.168.3.102

Subnet mask 255.255.255.0 255.255.255.0
5  CONNECTING with SetupTool
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5.1 How to Check and Set Personal Computer IP 
Address

This section shows the method for checking and setting a personal computer IP address (Windows 7/Windows 10).

 Open [Control Panel] and change the setting of "View by" to "Small icons."
 Click [Network and Sharing Center].

 Click [Change adapter settings].

�

�

�
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 Right-click an adapter to be connected to a code reader (Ethernet 3 in this example), and select [Properties] from the 
shortcut menu.

 Select "Internet Protocol Version 4 (TCP/IPv4)."
 Click the [Properties] button.

�

�
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 The setting of the IP address and the subnet mask can be checked or set as necessary.
 Click the [OK] button.
5  CONNECTING with SetupTool
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5.2 Starting SetupTool
Start SetupTool.
The [Connect] in the [Home] tab is displayed immediately after starting SetupTool.

When SetupTool recognizes a code reader, "Name," "Address," "Firmware Version," and "Status" of the code reader are 
displayed under the "Network" section and the information can be checked.
Whether the IP address matches with the one set in the connected personal computer can be checked in "Status."

<When the status is "Misconfigured">
This indicates the IP address of the code reader and the personal computer are not matched. Either one of the addresses 
needs to be changed.

<When the status is "Discovered">
This indicates the IP addresses are matched. A connection can be made by selecting the code reader icon and click the 
[Connect] button on the lower right of the screen.

Precautions

When a code reader is not recognized
When a code reader is not recognized, try the following operations:
 • Click [Update].
 • Check that the cables are properly connected.
 • Allow the communication in the settings of a firewall or security software.

For details, refer to the following:
Page 21 When communication with DataMan Setup Tool is not allowed by a firewall
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When a warning message appears
A warning message may appear, which indicates that a function of DataMan Setup Tool is blocked by the Windows firewall.
Select the checkboxes of "Private networks" and "Public networks," click the [Allow access] button, then continue the 
operation.

When communication with DataMan Setup Tool is not allowed by a firewall
When a firewall is enabled and communication with DataMan Setup Tool is not allowed, a code reader may not be recognized 
since communication is not possible.
To allow the communication in the Windows firewall, refer to the procedure below.
When using other software with a firewall function, refer to the manual of the software and allow the communication with 
DataMan Setup Tool.
The following shows the procedure for Windows 10.

Operating procedure
Select [Control Panel]  [System and Security]  [Allow an app through Windows Firewall] from Windows Start.
5  CONNECTING with SetupTool
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If [System and Security] cannot be found in [Control Panel], select "Category" for "View by."

 Click the [Change settings] button.
Check if "DataMan Setup Tool" is displayed in the list. If it is displayed, the operations in step  and  are not necessary.

 Click the [Allow another app] button.
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 Click the [Browse] button in the "Add an app" screen, select "SetupTool.exe" in the folder where SetupTool is installed, then 
click the [Add] button.
"SetupTool.exe" is stored in the following if the installation destination folder for SetupTool is not changed.
(Example) When the version of SetupTool is v6.1.5_SR1
C:\Program Files (x86)\Cognex\DataMan\DataMan Setup Tool for MELSENSOR Code Reader v6.1.5_SR1

 Select the checkboxes of "Name," "Domain," "Private," and "Public" for "DataMan Setup Tool" in the list, and click the [OK] 
button.
5  CONNECTING with SetupTool
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5.3 How to Check and Set Code Reader IP Address

Setting a static IP address to a code reader

 Click [Repair & Support] on the left side of the SetupTool screen and select a code reader icon displayed under the 
"Network" section.
 When the setting status of a code reader IP address is displayed on the right side of the screen, select "Use Static IP 
Address."

 Enter "192.168.3.102" for "IP Address" and "255.255.255.0" for "Subnet Mask" respectively, and click the [Apply] button.
Wait for the code reader to be restarted and the IP address to be changed. (Time required: 30 sec)

�

�

�
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 When the IP address is changed, click [Connect] on the left side of the SetupTool screen. Select the code reader icon to be 
connected, and click the [Connect] button on the lower right of the screen or double-click the icon.

Copying the static IP address of a personal computer
  Follow the same procedure as  and  in 'Section 5.3 Setting a static IP address to a code reader.'

 Click [] on the right side of [Copy PC Network Settings] and select an Ethernet port to be connected.
(Select the same port as the one selected in the procedure  in Section 5.1)

�

�
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 The IP address whose the fourth value of the selected Ethernet port is set to "0" is configured.
Set the forth value "0" to the different value from other devices (102 is entered in this example).
 Click the [Apply] button. Wait for the code reader to be restarted and the IP address to be changed. (Time required: 30 sec)
Perform the procedure of  in Section 5.3 Setting a static IP address to a code reader to connect.

�

�
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6 SetupTool SCREEN

6.1 Screen Configuration
The following shows the screen configuration when the code reader is connected.
The details of each screen are explained in Section 6.2 or later.

 • The layout can be changed.
 • The size of "Setting area" and "Image display area (Image Panel)" can be changed.

Shortcut Operation Icon Menu Tabs Operation Icons

Linked with the selected menu tab

Application Steps Setting Area

Image Display Area 
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 • "Result History" and "Code Quality" can be displayed.
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6.2 Shortcut Operation Icon
The following shows the operation icons which are always displayed on the upper left of the SetupTool screen.

 • Trigger: To read codes using the code reader.
 • Live: To switch a display mode between a motion video (Live) and a still image. It is switched to a still image during the 

operation.
 • Save Settings (F4): To save the set parameters to the memory of the code reader.
 • Reset Configuration: To reset the set parameters.

Trigger Save Settings (F4)

Live Reset Configuration
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6.3 Application Steps
A setting flow is always displayed on the left side of the screen. The code reader can be set in order from the top.
Not all the items need to be set.

Application Type
To select a reading condition from the pull-down menu. By doing so, the assistant 
functions in [Application Details] are enabled.
Even if the application type is set "Undefined," settings can be proceeded and codes 
can be read.
Optimize Image
To set for reading operation mainly. This is the area where 'Tune' is configured as the 
main setting of the code reader.
Code Details
To select codes to be read and set for the code reader to read multi-codes.
Most of the code types can be read using the initial setting, however, some code types 
such as 'GS1 DataBar' need to be enabled in this application step.
Application Details
To set 'Trigger Type,' 'Exposure,' and 'Gain' for acquiring images.
Assistant functions are enabled by linking with 'Application Type.'
Format Data
To set character strings to be output to a master device. This setting is configured by 
the following situtaion: appending control characters "STX" and "ETX," appending 
information including the code position to the character strings, and outputting a part of 
the read contents.
Inputs/Outputs
To set inputs and outputs using I/O lines.
Communications
To configure serial and Ethernet communication settings as well as industrial 
communication protocols such as SLMP protocol.
Save Settings
To save the set parameters to the memory of the code reader.
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6.4 Menu Tabs and Operation Icons
Basic settings can be configured according to 'Application Steps.' However, when executing the specific operation such as 
"Update Firmware" and "Read saved data" individually, the target operation icon needs to be selected from the menu tabs 
([Home], [Actions], [Settings], [System] and [View]).

Home
A setting tab for connecting a code reader.

Actions
Operation icons that instruct operation to the code reader are displayed.

Settings
Operation icons for setting the code reader are displayed.
The settings of 'Read Setups' and 'Code Quality' can be set in this tab.

System
Operation icons for a code reader system are displayed.
'Acquiring backup data', 'Updating the firmware version of a code reader,' and 'Initializing the code reader' can be executed in 
this tab.

View
Operation icons regarding a screen display are displayed.

Q & A
The description of each setting item is displayed.

Help
Various documents are displayed.
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6.5 Image Panel
Image Panel displays an image when reading operation is completed.

(1) When a code is read successfully, the code is enclosed with a green frame.
(2) The read data and cell size of the code in units of PPM are displayed in the screen.

(3) Operation and settings for the displayed image can be performed by using operation icons on the upper and lower part of 
the Image Panel.

(1)

(2)

(3)
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(4) Magnifying glass icons
To zoom in and out the displaying image.
(5) Autofit Mode
To restore the zoomed-in or zoomed-out image to the normal size.
(6) Pixel to Pixel Mode
To display pixel grids emphatically when a zoomed image is used.

(7) Reset ROI
To restore the entire image to the standard size when a reading region (a blue frame within the image) is adjusted.
(8) Enable/disable image transfer
To stop displaying an image in SetupTool when this function is disabled. However, images are kept being acquired and read 
by the code reader even if the image transfer is disabled.
(9) Enable/disable Focus Feedback on image while in Live mode
When this function is enabled, a bar indicating the focus of the lens is displayed during Live mode.
(10) Size
To change the resolution of an image to be displayed. The size can be changed among four patterns: Full, Quarter, 1/16 and 
1/64. Smaller image size can speed up the image trasnfer. The size also relates to the image quality of an image file to be 
saved. The reading time is not affected by changing the image size.
(11) Format
To change the file format of image data to be imported to a personal computer. The format can be switched among "JPEG," 
"Bitmap," and "PNG."
(12) Copy, Save Image, and Logging
"Copy" is for copying the displaying image and can be pasted on applications such as Excel and PowerPoint. "Save Image" is 
for saving the displaying image as an image file. "Logging" is for setting the function whose an image file is saved 
automatically.
(13) Exposure and Gain
To adjust the brightness of an image to be imported. Increasing the value can make the image brighter. Gain is adjusted when 
the exposure time cannot be extended.
(14) Focus
To adjust the focus of liquid lens.

(4) (11)(10)(9)(8)(7)(6)(5) (12)

(13)

(14)
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6.6 Result History
Result History displays reading result information such as read codes and reading time.
For the display of Result History, refer to 'View' in 'Section 6.4 Menu Tabs and Operation Icons.'

(1)  Clear: To clear result histories.
(2) Pause  Play: When pausing, it stops to display information in Result History even if codes are read.
(3) Copy: The selected contents of a result history can be pasted on other applications.
(4) Copy All: The whole result history can be pasted on other applications.
(5) Customize: To select items to be displayed in Result History.
(6) Filter: To filter the results being displayed.
(7) Enable Beeper on Good Read: This function cannot be used at this point.
(8) Logging: To perform and set logging and reporting.

The item to display in Result History can be selected from 'Customize' on the upper part of the Result History.
Result: A content that is output by a code reader. It is basically a read code.
Result Status: A result indicating whether reading is successful or failed.
Arrival Time: A record of time when a reading result is arrived in a personal computer.
Decode Time: Analysis time of the acquired image data. It is basically a reading process time.
Trigger Time: Time required from when a trigger signal is received to when the reading is completed.
Symbology: A type of a read code.
Read Setup: A read setup number which is used when the reading is successful.
Module Size: An average pixel number of a read code module (Thin lines for 1-D code, one module for 2-D code). The value 
is the same as PPM (Pixels Per Module).
When selecting a result history, the state when the code is read is displayed in 'Image Panel.'

(1) (2) (3) (4) (5) (6) (7) (8)
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6.7 Screen Layout Customization (1)
The screen layout can be customized.

Hiding operation icons
Operation icons are hidden by clicking [], and are displayed by clicking [] on the upper right of the screen.

Adjusting the area size
When moving a cursor which is close to a boundary between areas, the cursor is displayed as the mark shown below.
The area size can be adjusted by moving the mark vertically or horizontally with holding a mouse being clicked.
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6.8 Screen Layout Customization (2)

Displaying 'Image Panel' and 'Result History' side by side
Click the [View] tab on the screen and check that 'Image Panel' and 'Result History' are turned ON. 'Result History' is 
displayed on the right-most side of the screen at the first startup. When it is not displayed on the screen, click the [View] tab 
and turn ON 'Result History.'

 If 'Result History' is displayed on the right-most side of the screen, select it using a mouse and click the pin mark.

 When holding the mouse being clicked on the character part of the 'Result History' in the 'Result History' area, the cross 
cursor appears.
When moving the cursor with the mouse being clicked, the mark which is shown in the above image next to the blue arrow is 
displayed.
Move the cursor to a desired position to which the mark indicates. To display 'Image Panel' and 'Result History' vertically, 
move the cursor down.

�

�

Displays the panel to 

the left of the pane.
Displays the panel above 

the pane.

Displays the panel on 

the center pane.

Displays the panel below 

the pane.

Displays the panel to 

the right of the pane.

Displays the panel on 

the right-most side of the 

window.
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6.9 Screen Layout Customization (3)

Displaying 'Image Panel' and 'Code Quality' side by side
Click the [View] tab on the screen and check that 'Image Panel' and 'Result History' are turned ON.

 By dragging the [Code Quality] tab at the bottom of 'Image Panel,' a cross cursor appears.
Arrange the tab to a desired position by following the same procedure as Section 6.8 Displaying 'Image Panel' and 'Result 
History' side by side.
When 'Code Quality' has already been displayed on the screen, the procedure will be the same as Section 6.8 Displaying 
'Image Panel' and 'Result History' side by side.

�
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'Pin mark' and '' on 'Image Panel,' 'Result History,' and 'Code Quality'

 The collapsed part is displayed by selecting the part at the right-most side of the screen ('Result History' in the example 
above).
 By clicking the 'pin mark' to switch the direction of the mark from horizontal to vertical, the window is fixed and always 
displayed without collapsing to the side. By clicking the mark again to switch its direction from vertical to horizontal, the 
window is collapsed to the side.

 By clicking [], the window is removed from the screen. To display the removed window again, select it from the [View] tab 
on the screen.

�

�

�
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7 SETTING CODE READER

7.1 Installing a Code Reader
Points for installation

Distance
When the distance between a code reader and a work is close, the imaging range gets narrower and the target is captured in 
the larger size.
When the distance is far, the imaging range gets wider and the target is captured in the smaller size. If the distance is set too 
far, codes may not be read. For the appropriate distance, refer to the product overview in Code Reader CF 26 User's Manual.

Installation angle
The installation angle is the most important setting to read direct part marking codes. Especially for works which have high 
reflection, installing the code reader by tilting at the angle (10 to 20 degrees) toward codes can reduce reflections and improve 
the reading rate.

Direction
For direct part marking, the direction of the code reader may also affect the reading rate.
Especially for a code on a column-shaped work, the direction of the code reader may be limited.

Importance of pre-assessment and tests
Appropriate installation conditions need to be checked by executing pre-assessment and tests to stabilize reading.

<A code on a curved surface and the direction of a code reader>

Appropriate direction Inappropriate direction
7  SETTING CODE READER
7.1  Installing a Code Reader 39



40
7.2 Settings in Tune
Tune is a function to optimize focus, brightness (exposure and gain), and lightning patterns. The code reader can be 
configured easily by using tuning function.
The following shows the procedure for setting parameters using Tune.

Preparation for tuning
 • Set symbols to be read in [Code Details] of [Application Steps]. Some symbols are initially set as an enabled symbol.

A codes which is not set as an enabled symbol is not detected during tuning. Check if the symbol of the target 
code is enabled before tuning.

 • Click the [Live] button in [Optimize Image] of [Application Steps] to switch to Live mode.
 • Locate a target code close to the center of the reading range while checking 'Image Panel.'
* However, the image is blurred at this point because the image is not focused.
 • A green light emitted from a code reader is a sighting light called aimer. Locate a read target code to the center of the aimer.
* "Aimer Enabled" needs to be enabled.

 • When the installation location of the read target code is determined, click the [Live] button again to end Live mode.

Execute tuning
Tuning is started by clicking the [Tune] button.
The [Tune] button is switched to [Cancel] button during tuning.
During tuning, red, yellow and green circles are displayed on Image Panel and the process of adjusting a focus can be 
checked. A code surrounded by a green frame indicates that the code is recognized by the code reader. Additionally, a fine 
adjustment of a focus, brightness adjustment, and lightning pattern adjustment are performed.

When tuning is completed, the [Cancel] button is switched to [Tune].

When adjusting a focus When the code is recognized
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By enabling "Enable Beeper on Good Read" in [Inputs/Outputs] of [Application Steps], a beep sound is generated when a 
code is recognized during tuning.

Reading test
By clicking the [Test] button, an image is decoded according to the parameters set by tuning results.
The decoding status of the following items can be checked at a reading test.
 • Current Read Rate: A success rate of decoding from the latest 20 times.
 • Decode Time [ms]: Decode processing time (* excluding image acquisition time)
 • Min/Max Decode Time: The minimum and maximum decode time displayed on a graph in the "Read Performance" pane.
 • Found Symbologies: Types of detected symbols
 • Read Strings: Information read from a code
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7.3 Parameter Setting Using a Configuration File
Past parameter settings can be reflected to the code reader by using a configuration file which is saved previously.
The following shows the procedure of setting parameter using a configuration file.

Open Configuration

 Select the [System] tab.
 Click the [Open Configuration] button.

 Specify a configuration file in the file selection dialog to be displayed, and click the [Open] button.

�

�

�
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 After specifying the file, a message whether to restore network settings appears. Select [Yes] or [No] as necessary.

�
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8 Application Steps

8.1 Optimize Image
Mainly, settings for reading operation are configured. This is the area where 'Tune' is configured as the main setting of the 
code reader.
Optimize Image consists of three buttons: [Live], [Tune], and [Test]. Each button has a drop-down window to set additional 
options.

Precautions
Do not perform 'Save Settings' during tuning and testing in Live mode. Settings cannot be saved correctly.

Live
This function can be used to monitor images whose the code reader captures and include codes to be read within the field of 
vision.
Operation options for performing a live display can be set by the drop-down window of the [Live] button.

Precautions
Use the [Test] button instead of the [Live] button to check the operation after tuning because the operation in Live mode is 
performed with the unique exposure control.

Decoding
Select this checkbox to read codes from captured images.

Focus Feedback
By selecting this checkbox, a bar which indicates the focus of lens is displayed on the right side of the Image Panel.

When the code is focused When the code is out of focus
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Automatic Exposure
Select this checkbox to make the code reader automatically determine the best exposure time.

Precautions
When changing the settings of automatic exposure and high frequency lights in Live mode, the changed contents are 
discarded when Live stops.

Tune
This function automatically configures the settings according to the reading environment.
For details, refer to 'Chapter 7 Section 7.2 Settings in Tune.'

Test
This function can actually test for reading codes by using created settings.
Additionally, the number of trigger input can be set by using "Trigger On" and "Trigger Off" in the drop-down window of the 
[Test] button.

Note: The image transmission may be disabled when codes are read at high-speed because the speed may be limited by 
reading settings, codes to be read, or a connection interface.

Trigger On Trigger Off Trigger occurrence frequency
20 ms 1980 ms 0.5 times (0.5 Hz) per second

20 ms 980 ms 1 time (1 Hz) per second

20 ms 480 ms 2 times (1 Hz) per second

20 ms 180 ms 5 times (1 Hz) per second

20 ms 80 ms 10 times (1 Hz) per second
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Code reading time can be checked on a graph. Click the [Clear] button to reset the graph.
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8.2 Code Details
Code types (symbols) to be read by using the code reader are specified. By selecting the checkbox of each symbol, the 
symbol is specified as the reading target code. The unselected symbols cannot be read. The selected symbols are displayed 
with the orange background.

Note: A license needs to be purchased for VeriCode. EAN.UCC Composite of a stacked code is used with DataBar.

Disable Untrained Symbologies
When codes are trained with this checkbox being selected, all the other symbols except for the trained symbols cannot be 
selected.
When codes are trained without selecting this checkbox, target symbols can be added after training the codes.

Disable All Symbologies
All checkboxes of set symbols are cleared.

Enable All Symbologies
All checkboxes are selected.
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Automatic Symbology Detection
This button is clicked when the code symbols to be read are uncertain.
Perform the Live display in advance for a focus adjustment to acquire an image which is focused on a code.

 Click [Automatic Symbology Detection].

 This is the mode that the code reader captures an image automatically and determine the code type.

 A symbol which is detected from the captured image is displayed in the "Found Symbologies" area.
 Click the [OK] button.

 The checkbox of the symbol is selected to read the detected symbol.

�

�

�

�

�
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How many codes do you need to read for each trigger?
The number of codes to be read is specified (1 is set as a default). It can be set if a captured image contains multiple codes.

 Set the number of codes to be read in "Number of Codes."
 When "No" is selected for "Should partial result be reported as a good-read?" and when the code reader is set to read 
multiple codes, the read result is not returned until the same number of codes are read as the set number of codes. (For 
example, when 2 is set for the number of codes, the result is not returned until two codes are read.) To make the read result 
return even if only one code is read, select "Yes" for "Should partial result be reported as a good-read?."
 Set values for "Maximum number of codes per symbology you need to find." In the example, the setting is configured to 
read two Data Matrix codes in an image.
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8.3 Application Details
Settings such as trigger type, delay type, timeout, interval, burst length, exposure, and gain can be configured by using 
assistant functions that can help for configuring these settings.

Trigger settings

Trigger Assistant
By selecting an application type, trigger options suitable for the application type can be checked and set using the trigger 
assistant function.
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Trigger Type
 • Single (external)
Exposure and image acquisition are performed once per trigger.
Additionally, this trigger mode supports for a timeout setting.

 • Continuous (external)
Images are acquired at the specified image acquisition interval as long as the trigger signal remains active. The code reader 
stops receiving the trigger signal once a code is read. The timeout setting value is equivalent to the trigger interval in this 
trigger mode.
If the code cannot be read when the trigger signal stops, the result will be "No Read" indicating that a readable code is not 
contained in an image.
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 • Burst (external)
Multiple images are acquired per trigger and the first symbol detected among the images is decoded.
The number of image to be acquired and the interval between each image acquisition can be set. Additionally, this trigger 
mode supports a timeout setting.
A timeout setting value is set to read for each acquired image, not for the whole burst.

 • Self (internal)
Codes are read by acquiring images at the set interval configured in "Interval" without external trigger inputs. Additionally, the 
timeout time is equivalent to the value of the set "Interval" in this trigger mode.
Some parameters can be configured to set standby time until the next code is read, and whether the code reader reads the 
same code repeatedly.
This trigger mode does not support automatic exposure.
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 • Presentation (internal)
Images are acquired and codes are read without external trigger inputs. Unlike the trigger type of "Self" which acquires 
images at equal intervals, the image acquisition interval varies depending on each code. This trigger mode does not support a 
timeout setting.
Some parameters can be configured to set standby time until the next code is read, and whether the code reader reads the 
same code repeatedly.
This trigger mode supports automatic exposure.

Motion Detection
This setting can be configured when "Self (internal)" or "Presentation (internal) is selected for a trigger type.
The code reader starts the operation of a set trigger type by detecting moving objects within the field of vision.

Enabled
The code reader does not acquire images, but it detects in the background whether there are any moving objects within the 
field of view.
When any motions are detected, the code reader starts operation in the "Presentation (internal)" or "Self (internal)" trigger 
mode.

Timeouts
The time from when the code reader enables triggers to when it returns to the motion detection mode can be specified in 
seconds. However, the timeout time is reset each time when motion detection or reading a code is successful.

Motion Detection Sensitivity
The degree to which the code reader detects motion can be set in three stages: Low, Medium and High.
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Interval Assistant
When "Self (internal)" or "Continuous (external)" is selected for a trigger type, the image acquisition interval can be calculated 
by using Interval Assistant. Select one of the application details to be input such as the field of view size, distance to code and 
code element size, and set the required values to calculate the interval.
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Exposure

Exposure Assistant
When an application type other than "Indexed, Stationary" is selected, the optimized exposure time can be set by using 
Exposure Assistant. Select one of the application details to be input such as the field of view size, distance to code, and code 
element size, and set the required values to calculate the exposure time.

Automatic Exposure
The best exposure settings are automatically determined in the code reader.

Manual Exposure
The exposure time can be set in microseconds.
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Maximum Exposure
Configure the maximum exposure time that can be set when executing [Optimize Brightness] in the [Action] tab. By clicking 
the [Optimize Brightness] icon, the appropriate exposure setting with the value below the 'Maximum Exposure' value can be 
obtained.

Gain Factor
The sensitivity of an image sensor. Increasing the value can make an acquiring image brighter but the image quality becomes 
lower. Increase the 'Gain Factor' value when the 'Exposure' value cannot be increased.

Maximum Gain Factor
Configure the maximum gain factor value that can be set when executing 'Optimize Brightness' in the [Action] tab. By clicking 
the [Optimize Brightness] button, the appropriate gain factor which is below the value of the 'Maximum Gain Factor' value can 
be obtained.
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Decode Settings
For trigger types whose codes are read by external trigger inputs, triggers can be input at the required timing. For example, 
when a code reader reads a code from a target object flowing on a conveyor, the code can be read by inputting triggers at the 
appropriate timing. However, when the code reader generates triggers internally for reading codes, it cannot be triggered at 
an arbitrary timing; the same target object code may be read multiple times. The following can be set to prevent the 
occurrence of such an event.

Never Read Same Code Twice
This setting prohibits the code reader to read the same code continuously.

Don't Reread Last N Codes
When reading multiple types of codes, N codes read from the last are not read again. The example is shown as below. When 
setting 2 for N, the three different types of codes (A,B, and C) are read by the following operation.

OK OK NG NG OK OK

The first time 

A is read

The third time 

A is read

The sixth time 

A is read

The fifth time 

C is read

The fourth time 

B is read

The second time 

B is read

Read OK Read OK This code is not read 

because A is included 

in the last two codes 

which have been read 

successfully.

This code is not read 

because B is included 

in the last two codes 

which have been read 

successfully.

This code is read 

because C is not 

included in the last two 

codes which have been 

read successfully.

This code is read 

because A is not 

included in the last two 

codes which have been 

read successfully.
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Delay Mode
After First Read: A delay occurs after the first code is read; therefore, a timer is not reset.
This means, in a trigger mode which handles multiple images by reading codes continuously, a code is read repeatedly when 
the code is kept in front of the code reader for an interval longer than 'Re-read delay.'

After Last Read: A timer is reset every time when the code reader detects a code.
The code is not read again even if the code is kept in front of the code reader.

♦ After First Read

♦ When the set value of 'Re-read delay' is longer than 
the trigger interval

♦ When the set value of 'Re-read delay' is shorter 
than the trigger interval

Trigger 

interval

Read
Read

Re-read delay

500ms

Re-read delay

2100ms

Reading is not performed 

because a trigger is generated 

during the re-read delay.

Reading is performed because 

the duration of the re-read 

delay ends.

Reading is performed 

because the duration of 

the re-read delay ends.

Interval of 2000 ms Interval of 2000 ms

Trigger 

interval

Trigger 

interval

Read

Re-read delay 

after resetting the 

timer 

2100ms

Re-read delay

2100ms

♦ After Last Read

Re-read delay is reset every 

time when a code is detected 

within the field of vision.

Interval of 2000 ms
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8.4 Format Data
The format of output character strings and output contents for each reading code are set.

No Read Output String
Character strings to be output when code read has failed can be set. If this item is not set, no character strings will be output 
when a code cannot be read.
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Basic Formatting
The type of a format which is used when outputting codes read by the code reader can be set. Output contents can be 
configured for each code separately, or common output settings can be configured under the [Universal] tab. Configuring 
either one of the settings is recommended.

 Select the checkbox of "Standard" for codes to set.
 After selecting contents to be output in "Data," click the [Add] button to add output data.
 When adding CR/LF to the end of output data, select the checkbox of "CR/LF."
 By clicking the [Test] button, the result of the last read code which is output by the set format can be checked on the right 
side window.
* When outputting the read code result enclosed by control character codes such as STX (Start of Text) and ETX (End of 
Text), set hexadecimal ASCII codes for leading and terminating text respectively.
Leading Text: \x02 Terminating Text: \x03 (Hexadecimal characters can be specified by entering \xnn (nn indicates 
hexadecimal ASCII codes).)

�

�

�

�
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8.5 Inputs/Outputs
The operation of the [TRIG] button and the [TUNE] button, inputs, and outputs can be set.

TRIG Button
By pressing the [TRIG] button for three seconds, all the selected operations can be performed.

Optimize Brightness
Exposure time is optimized.

Optimize Focus
A focus is optimized.

Read Configuration Code
Read Configuration Codes are executed. 

Train Code
Codes are trained.
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Set Match String
When executing 'Match String Validation' of Data Validation, set the read data to "Match String."

Test Mode
This mode can be used when "Single," "Burst," or "Self" is set for trigger type.
Additionally, it can be selected by unselecting all the other checkboxes in the [TRIG Button] tab.
A reading test is performed by inputting triggers at the trigger interval specified in the test mode.
For the trigger setting of the test mode, refer to the Test section in 'Section 8.1 Optimize Image.'
To end the test mode, press the [TRIG] button for three seconds again.

Disable Reader Button
The [TRIG] button is disabled.
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TUNE Button
Tuning is executed by pressing the [TUNE] button for three seconds.

Disable Reader Button
The [TUNE] button is disabled.
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Inputs
The operation of the code reader can be set in the "Inputs" tab. The code reader performs the set functions by receiving 
signals externally.

Trigger On
Codes are read by input signals.

Trigger Off
Reading operation ends by input signals.
An operation example is shown as below when the following settings are configured.
Trigger Type: Continuous
Input 0: Trigger On
Input 1: Trigger Off
When input 0 receives signals, reading operation starts. When a code is read, the reading operation ends. However, when a 
code cannot be read and "Continuous" is set for a trigger type, the operation continues until the code is read. To end the 
operation, input the "Trigger Off" signal.
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Train Code, Optimize Brightness, and Train Match String
Refer to 'TRIG Button' in 'Section 8.5 Inputs/Outputs.'

Optimize Focus and Read Configuration Code
Refer to 'TRIG Button' in 'Section 8.5 Inputs/Outputs.'

Tune
Refer to 'TUNE Button' in 'Section 8.5 Inputs/Outputs.'

Allow Buffered No Read Images
This function can be used only when "Continuous" is selected for a trigger type.
When "Continuous" is set for a trigger type, even if a buffer setting is configured to save all images, the images which cannot 
be read are not saved to a buffer. By using this function, only the images which cannot be read can be stored in the buffer.

Clear Outputs
This is a function to reset all the outputs immediately after the signal is input. An output delay setting is not reset.

Debounce Delay
Detection time required for the code reader to recognize a trigger signal being enabled is set.
Set a small value for fixing the line-noise of electrostatic discharge (ESD), and a large value for fixing the noise of 
electromechanical relays. Adjustment of the setting may be required to select the best value that fits the manufacturing 
environment.
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Outputs
Output signals are set.

Strobe
When using external lights, this function can provide strobe signals to the lights.

Read/No Read
This function can output signals respectively when a code is read or not read.

Validation Failure
A signal is output when validation is failed.

Trigger Overrun/Buffer Overflow
A signal is output when each error occurs.
Trigger Overrun: It occurs when a trigger is input before the code reader prepares for an image acquisition, such as when a 
trigger is input while an image is acquired.
Buffer Overflow: It occurs when there is no storage area for acquired images. This indicates that the processing cannot keep 
up with the volume of acquired images. The overflow occurs when the decoding time takes longer than the image/trigger 
interval.

Open/Closed
A signal is output as follows when an event is occurred.
Open: A signal ON  OFF
Closed: A signal OFF  ON

Pulse Width
The pulse width of a signal is set.
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Output Delay
This function can delay signal outputs.
It can be used when "Manual," "Single," "Burst," or "Continuous" is selected for a trigger type.
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8.6 Communications
The settings for connecting the code reader with the connected devices via serial or Ethernet (SLMP, CC-Link IE Field 
Network Basic, EtherNet/IP*1, and MODBUS/TCP*1) communication are configured.
*1 Only the CF37 series supports it.

Serial
Configure serial port settings.
For a setting example when communicating the code reader with a programmable controller via serial communication, refer to 
the following:
Code Reader Connection Guide

Speed, Parity, Data Bits, and Stop Bits must be configured same as the communication target.

Ethernet
Select the checkbox of a protocol to be used on Ethernet.
For a setting example when communicating the code reader with a programmable controller, refer to the following:
Code Reader Connection Guide
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8.7 Save Settings
'Save Settings' is rather a required work item than a work step. It saves current settings to the persistent memory of the code 
reader so that the same settings can be applied when restarting the code reader. SetupTool also saves a backup file to a 
default backup folder in the personal computer in use.

Precautions
Do not perform 'Save Settings' during tuning and testing in Live mode. Settings cannot be saved correctly.

 Click [Save Settings] of [Application Steps].
 Click the [OK] button after a confirmation dialog appears.

 'Save Settings' can also be performed from the [System] tab.
 Additionally, settings can be saved to a personal computer as a file by clicking [Save Configuration...].

�

�

� �
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9 HOME TAB FUNCTIONS

9.1 Backup
This is a function to create a code reader backup file.
Even when multiple code readers are selected, the backup files can be created at once.

Precautions
In the following cases, the [Backup] button is grayed out and the button cannot be clicked.
 • A matched IP address is not set.
 • The code reader is connected with SetupTool.

The backup procedure is shown as below.

 Select the [Home] tab.
 Click [Backup].
 Select a code reader to create a backup file.
 Click the [Backup] button.

�

�

�

�
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 The backup status is displayed in the "Mass Device Backup" dialog. Check that "Completed" is displayed and click the 
[Close] button.

�
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9.2 Restore
This is a function to restore a code reader using a backup file.

Precautions
In the following cases, the [Restore] button is grayed out and the button cannot be clicked.
 • A matched IP address is not set.
 • The code reader is connected with SetupTool.
 • A valid configuration source is not specified.

The restoring procedure is shown as below.

 Select the [Home] tab.
 Click [Restore].
 Select a code reader to restore.
 Select 'Configuration File' from the "Configuration Source" section, and click the file specification button on the right side of 
the item.

�

�

�
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The following four options are available as a configuration source.
 • Configuration File
To restore with a specified backup file.
 • Device
To select a code reader which exists on a current network, and restore with the setting information of the 
selected code reader.
 • Latest Backup
To restore with the newest backup file among the backup files of the selected code reader.
 • Factory Defaults
To restore values to the factory defaults.

 The "Backups" folder is displayed and each folder with the name of the code reader is displayed. The previously saved 
backup files are stored within each folder. Select a backup file to be used for restoration among the backup files.

 Check that the selected backup file is correct according to the displayed file name, and click the [Restore] button.

�
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When restoring communication settings, click the [Restore with network settings] button from the submenu of 
the [Restore] button.

 The restoring status is displayed in the "Restoring Devices" dialog. Check that "Completed" is displayed 
and click the [Close] button.
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9.3 Update Firmware
This is a function to update a code reader firmware.
The procedure for updating a firmware is shown as below.

 Select the [Home] tab.
 Click [Update Firmware].
 Select a code reader to update the firmware.
 Click the file specification button on the right side of "Firmware File."

 Specify a firmware file (a GZ file) in the file selection dialog to be displayed.

�

�

�

�
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 Check that the selected firmware file is correct according to the displayed file name, and click the [Upload Firmware] 
button.

 Click the [Yes] button in the confirmation dialog to be displayed.

 The update status is displayed in the "Mass Firmware Update" dialog.
Check that "Completed" is displayed and click the [Close] button.
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9.4 Language Settings
SetupTool can switch a language between Japanese and English.
The procedure for switching a language in SetupTool is shown as below.

 Select the [Home] tab.
 Click [Options].

�
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 Select "Language" in the Options screen to be displayed.
 Click the [OK] button in the information dialog to be displayed.
 Click the [OK] button in the Options screen.
 Restart SetupTool.

�

�
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APPENDIX
Appendix 1 Read Setups 
A code reader can have up to 16 different settings. This means a code can be read by using up to 16 settings. If the code is 
failed to read by the first setting, the second setting is used, and if the reading is failed, the third setting is used and so on. 
When the code is read successfully during the process, the reading ends at that time and no further reading is performed. 
Additionally the code can be trained for each setting.
The procedure for setting read setups is shown as below.

 Select [Read Setups] in the [Settings] tab.

 Current setting information is displayed.

�

�
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 By selecting [Add Setup], the "Add Setup" dialog is displayed.
Select "Use defaults" or "Copy values from setup" and click the [OK] button to add the setting.

Use defaults
Add new settings from default values.

Copy values from setup
Copy values from existing settings and add new settings.

 Setup 1 is added.

 For changing each parameter of the added settings, change the settings on the table displayed in the Read Setups screen 
as indicated in the procedure . Alternatively, the settings can be changed by clicking the icon of each setting in each 
application step screen or in the [Settings] tab.
When tuning the code reader in each read setup setting, it must be performed by selecting a read setup in the [Settings] tab.

�

�

�
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 Set the execution order of created read setups.

Last Successful Decode
When two settings, Setup 0 and Setup 1, are present and the last code is read using Setup 1, the next code reading will be 
started using Setup1 at first.

Setup 0
A code is always read by determined settings. A setting to be used at first can be selected. When Setup 2 is selected among 
Setup 0, 1, 2, and 3, the execution order of the read setups will be Setup 2  3  0  1. (Note that the order can be changed 
from the [Change Order] icon.)
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Appendix 2 Code Quality
CF Series can verify whether or not the acquired image satisfies a quality guideline which is defined by the code quality 
standard. For further information on the specific code quality standard and metrics, refer to 'DataMan Communications and 
Programming Guide.'

 Select [Code Quality] from the [Settings] tab.

�
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 Select the metric of a reading target code. (AIM-DPM is selected for Data Matrix in this example.)

 By clicking the [Trigger] button to acquire an image and read the code, the result is displayed in the "Code Quality" screen.
The reading result can be output with the whole grades or the grade of each item being added. For details, refer to 'Appendix 
8 Adding code quality results (grades).'

�

�
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Appendix 3 External Transfer of Images and Reading 
Results Using FTP

CF Series can transfer and save images (from successful reads, unsuccessful reads, or both) as well as read results to an 
external location using FTP. The following describes the method of saving images which cannot be read and saving code 
reading information.

 Select [Buffering and Transfer] from the [Settings] tab.

�
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Saving an image which cannot be read

 Configure the following settings.
"What Results to Buffer": No Read
"What Images to Buffer for a Result": Auto
"No Read Image Mode": No Read Image Period
"Size": Full
"Format": Bitmap
(Set "Full" and "Bitmap" to save the image for reproducing the phenomenon.)

�
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 Configure the following settings in the [Image FTP Transfer] tab.
Set information according to the FTP server to be used (Server Address, FTP port (normally 21), Username, and Password)
"File Name": Set a file name to be used as an image (default) file name. Additionally, when storing the file in a different place 
from the root directory, set a path name together.
When saving the file in the 'test' folder under the root folder: \test\image
"Max Append Value": Set the maximum number of files can be saved. The initial value is 999. Change the value as necessary.
"Transfer Mode": FTP - Runtime

�
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Saving code reading information

 Configure the following settings in the [Result FTP Transfer] tab.
Set information according to the FTP server to be used (Server Address, FTP port (normally 21), Username, and Password)
"File Name": Set a file name to be used as a result.txt (default) file name. Additionally, when storing the file in a different place 
from the root directory, set a path name together.
When saving the file in the 'test' folder under the root folder: \test\result.txt

 Select the checkbox of "Enable Result Transfer via FTP."

�
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Appendix 4  Supplemental Remarks for Tuning (1)

Appendix 4 Supplemental Remarks for Tuning (1) 

Adjusting a reading region

Tuning after setting a lightening pattern
A lightening pattern can be set to turn ON and OFF the lights by clicking each light on the front view of the code reader which 
is displayed in [Optimize Image] of [Application Steps].
When executing tuning by clicking [] on the right side of the [Tune] button and disabling "Tune Light Banks," tuning with the 
set lightening pattern is executed.

Focus adjustment in Tune may be failed if a work is a 3D 
object.
Additionally, a specific code may not be tuned when multiple 
codes are present within the reading range.
The corrective action for these cases can be taken by 
adjusting the reading region. The right image shows works 
with different height that are captured on the right and left 
side of the image. The bottom right code of the image is 
tuned by adjusting the reading region which is displayed with 
a blue frame.
Smaller reading region can shorten the tuning and reading 
time, and improve the reading rate.
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Appendix 5 Supplemental Remarks for Tuning (2) 

Tuning condition setting
Conditions for executing tuning can be set by clicking [] on the right side of [Tune].

Tune Light Banks: To execute tuning for optimizing a lightening pattern.
Force Exhaustive Tuning: To execute tuning by attempting all the lightening patterns.
Enable Filter Tuning: To execute tuning by using image filters.
Optimize Focus During Tuning: To execute tuning for optimizing a focus of variable focus liquid lens.
Exclude Ambient Light Results: By enabling the setting, the pattern setting that keeps all the code reader lights turned OFF 
(reading codes using ambient light) is not selected.
When disabling "Train Code After Tuning" which is above the [Live] button, a code is not trained after tuning.
Whether or not a code is trained successfully can be checked by a completion message displayed in 'Image Panel' after 
tuning.
To cancel the code training, click [Untrain Code] on the upper right of 'Image Panel.'

Train Code
When 'Train Code' is executed, only codes that are matched with trained conditions are read in the read settings.
Information such as a code type, code size, module size, and polarity is trained.
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Appendix 6 Tuning After Optimizing Maximum 
Exposure Time

Exposure time indicates the time for acquiring an image. The longer the exposure time, the brighter the image becomes. 
However, if a target code moves (including vibration), the image blur is likely to be occurred. Additionally, the exposure time is 
added to the reading time; therefore, the whole processing time is prolonged.
The maximum exposure time of this code reader is '200,000 s (200 ms).' When executing tuning with the initial setting for a 
CF26 Series type using a polarized filter ('LR' at the end of the type name), note that the maximum value may be set for the 
exposure time.
It is important to execute tuning after optimizing the maximum exposure time.

Restricting the maximum exposure time

 Click [Application Details] of [Application Steps].
Enter a value of "Maximum Exposure (s)."
* Setting too small value may cause to fail tuning.

Setting exposure time adapted to the moving speed of a work

 Set "In-Motion" for [Application Type] of [Application Steps].
Click [Application Details] and click [Exposure Assistant].

�
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 Enter a value of each required parameter and click [Save and Close].
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Appendix 7 Exposure Time, Gain Factor, and Image 
Filtering

Adjusting exposure time and gain factor
The larger the values of 'Exposure' and 'Gain Factor,' the brighter the acquiring image becomes. Increase the "Gain Factor" 
value when the 'Exposure' value cannot be increased. 'Gain' indicates the sensitivity of an image sensor. Increasing the value 
can make an image brighter but the image quality becomes lower.

 Click [Application Details] of [Application Steps].
 Adjust values of 'Exposure' and 'Gain Factor.'

Image filtering
'Image Filtering' performs filtering processing on an acquired image and adjusts the image for making it easy to be read.
It is recommended to use only when a code is very difficult to be read.
It is based on the conditions (such as lightening patterns including installation conditions and external lights) of reading codes 
without 'Image Filtering' that are set by performing pre-assessment and test. 'Image Filtering' is taken into 'Read Setups.'
'Read Setups' is a function to switch set read parameter patterns internally. For details, refer to 'Appendix 1 Read Setups.'

 Click the character part of [Optimize Image] in the [Settings] tab.

�
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 Click the [Add] button and select a filter type to use from "Filter Properties" to set the filter parameters.

 Set an image to use for reading codes.
Original: Read an acquired image.
Filtered: Read a filtered image.
(In this example, the set filtered image is used for reading DataMatrix codes.)
 By selecting a code to be read for "No Read Image" (DataMatrix in this example), a filtered image is displayed even when 
code reading is failed.
<Frequently used filter types>
Dilate: An image with a bright part being dilated.
Erode: An image with a dark part being dilated.
Stretch: To enlarge a difference of brightness and darkness of an image. When increasing the 'Low' value, the gray color in 
the image will become closer to black. When decreasing the 'High' value, the gray color will become closer to white.

�
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Appendix 8 Customizing Output Data

Adding the number of a read setup whose reading is succeeded to output data
For details of the read setups settings, refer to 'Appendix 1 Read Setups.'
The following describes the setting method when the target code is Data Matrix.

 Select the [Format Data] of [Application Steps] and select the checkbox of "Standard" for "Data Matrix." Click "Standard" to 
move to the link.

 Add "<Used Read Setup>" from "Data." When two read setups are trained and a code is read with the first read setup 
setting, read data is output with "0" being added to the data. For the second read setup, "1" added to the read data. (In the 
example above, <Used Read Setup> is added on top of <Full string> and <SP> which have already been added in advance.)

�
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The following shows the output image with or without setting <Use Read Setup>.
<Full string>:

<Full string><SP><Used Read Setup>:

Adding code quality results (grades) 
It is assumed that the setting for executing Code Quality has already been set.
When other settings are required, add the settings to "Universal" as this setting is added to "Universal" of [Format Data].

 Select [Code Quality] from the [Settings] tab, and select the [Result String] tab.
 Select the checkbox of "Append Code Quality Data to Result String." By doing so, data is output by adding the data of each 
quality item to a reading result. The display example is shown below.
<A read result only>

<With selecting the checkbox (Data prefix: abbreviation, data report: when a grade is set) >

<With selecting the checkbox (Data prefix: abbreviation, data report: when a grade is set) >

The checkbox of "Output Overall Grade" can also be selected when adding the whole grades. ("Output Overall Grade" cannot 
be executed without outputting data of each quality item.)

<With selecting "Output Overall Grade" (Data prefix: abbreviation, data report: when a grade is set) >
Without selecting the "Output Overall Grade" checkbox

With selecting the "Output Overall Grade" checkbox

�

�

Overall Grade
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Precautions
The following parameters of CF37 series cannot be changed from the default.
 • "Output Overall Grade" [default: selected (output)]
 • Prefix For Data [default: Acronym]
 • Reported Data [default: Grade]
 • Separator Before First PCM Value [default: - (hyphen)]
 • Separator Between PCM Values [default: , (comma)]
APPX
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Appendix 9 Setting an IP Address to a Code Reader 
(DHCP)

In the default setting of a code reader, the IP address is automatically set using DHCP server. This section explains the 
procedure for changing the setting of the code reader in which a static IP address has already been set to the setting whose 
the IP address is automatically set using DHCP.
Start SetupTool.

 Click [Repair & Support] on the left side of the SetupTool screen and select a code reader icon displayed under the 
"Network" section.
 After the setting status of the code reader IP address is displayed on the right side of the screen, check that "Use Static IP 
Address" is selected.

Select "Use DHCP Server."
Click the [Apply] button.
Wait for the code reader to be restarted and the IP address to be changed. (Time required: 30 sec)
The IP address is automatically set after starting the code reader.

�
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Appendix 10Virtual Device
A virtual device can be created based on a configuration file or a default setting device. The created virtual device can be 
connected from SetupTool in the same way as a regular device. However, all settings are read-only and therefore the settings 
cannot be changed and operated. The virtual device is mainly used for checking the content of a saved configuration file in 
SetupTool.

 Select [Repair & Support] in the [Home] tab and select [Add Virtual Device].

 Select either "Create device from configuration file" or "Create a device with factory defaults" and click the [Next] button.

�
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 A virtual device is created. A character "V" which indicates a virtual device is displayed on the code reader icon.

�

� �

�

�

When "Create device from configuration file" is selected When "Create a device with factory defaults" is selected

     After selecting a configuration file, select a model and click the [Finish] 

button.

      Set "Device Name," "Device Type," "Firmware Version," and "Model" 

and then click the [Finish] button.
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Appendix 11 Outputting any characters from a 
decoded character string

A character string read with a code reader can be output by setting a range.
The output range can be set either on a code reader or programmable controller side.
This section shows a procedure to specify a range using a string of 10 characters (1234567890).

On a code reader side
When specifying an output range on a code reader side, use SetupTool.

Setting an output range of a character string
Select the [Format Data] of [Application Steps] and select the checkbox of "Standard" for a code to be set. Click "Standard" 
to move to the link.

Select "<Sub-string>" of "Data," and click the [Set Sub-String Range] button.

�

�
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Enter an output range in "Sub-string range," and click the [OK] button.
Examples of an output range which can be specified are as follows:

Ex.

Output range: from the 1st to 3rd characters
Enter "-3."

Click the [Add] button. The specified output range is displayed.

Ex.

Output range: from the 1st to 3rd characters
"<Sub-string:-3>" is displayed.

Click the [Test] button in "Output Options." A string based on the specified output range is displayed.

Ex.

Output range: from the 1st to 3rd characters
"123" is displayed.

Output range Sub-string range
From the 1st to 3rd characters -3

From the 2nd to 5th characters 2-5

From the 8th to last characters 8-

�

�

�
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Input a trigger, and a character string of the set range is output in the screen and "Result."

Ex.

Output range: from the 1st to 3rd characters

Ex.

Output range: from the 2nd to 5th characters
2 APPX
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Ex.

Output range: from the 8th to last characters

To add CR/LF at the end of an output data, select the checkbox of "CR/LF" for "Terminating Text."
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On a programmable controller side
When specifying an output range of a character string on a programmable controller side, the range can be specified by 
creating a program using the MIDR instruction.
The specifications and operation examples when using the MIDR instruction in MELSEC iQ-R series CPU modules are 
shown bellow.

For details on the MIDR instruction, check in the manual of the CPU module used.

Extracting the specified string data MIDR(P)
These instructions extract data at any position in string data, and store the extracted data in the device number specified by 
(d) and later.

Execution condition

Setting data

Description, range, data type

Applicable devices

Ladder ST
ENO:=MIDR(EN,s1,s2,d);
ENO:=MIDRP(EN,s1,s2,d);

FBD/LD

Instruction Execution condition
MIDR

MIDRP

Operand Description Rang
e

Data type Data type (label)

(s1) Character string or the start device containing the character 
string

 Character string ANYSTRING_SINGLE

(d) Start device for storing the character string data of the operation 
result

 Character string ANYSTRING_SINGLE

(s2) Start device for storing the location of the start character and 
the number of characters
(s2): Location of start character, (s2)+1: Number of characters

 16-bit signed binary ANY16_ARRAY
(Number of elements: 2)

EN Execution condition  Bit BOOL

ENO Execution result  Bit BOOL

Operand Bit Word Double word Indirect 
specifica
tion

Constant Others

X, Y, M, L, SM, 
F, B, SB, FX, 
FY

J\ T, ST, C, D, 
W, SD, SW, 
FD, R, ZR, 
RD

U\G, 
J\, 
U3E\(H)G

Z LT, LST, 
LC

LZ K, 
H

E $

(s1)            

(d)            

(s2)            

(s1) (d) (s2)

EN ENO

ds1

s2
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Processing details
 • These instructions extract the data by the number of characters specify by (s2)+1 from the location specified by (s2) in the 

character string data stored in the device number specified by (s1) and later, and store the extracted data in the device 
number specified by (d) and later.

 • The NULL code (00H) indicating the end of a character string is automatically added to the end of the character string data.
 • If the number of characters in the device specified by (s2)+1 is '0', no processing is performed.
 • When the number of characters of the data in the device specified by (s2)+1 is '-1', the data till the last character data in the 

device specified by (s1) is stored in the device specified by (d) and later.

Operation error

(1) Position specified by (s2): 5th character
(2) ASCII code ((s2)+1)th character from the specified position

(1) Position specified by (s2): 5th character

Error code (SD0) Description
2820H There is no NULL code (00H) in each setting area in the device/label memory in the device specified by (s1) and later.

3405H The number of characters of the character string in the device specified by (s1) exceeds 16383.

An out-of-range value is set to (s2).
• The value in the device specified by (s2) is 0 or less.
• The value in the device specified by (s2)+1 is other than the valid values (-1, 0, 1 or bigger).
• The value in the device specify by (s2) exceeds the number of characters in the device specified by (s1).
• The value obtained by adding those in the devices specify by (s2) and (s2)+1 exceeds the number of characters in the device 

specified by (s1).

41H (A)42H (B)
43H (C)44H (D)

45H (E)46H (F)
47H (G)48H (H)

45H (E)46H (F)
47H (G)48H (H)
49H (I)4AH (J)
4BH (K)00H

49H (I)00H

"ABCDEFGHIJK"

"EFGHI"

b15 b0∙∙∙ ∙∙∙b7b8
b15 b0∙∙∙ ∙∙∙b7b8(s1)

(s1)+1
(s1)+2
(s1)+3
(s1)+4
(s1)+5

(d)
(d)+1

(d)+2

5
5

(s2)
(s2)+1

(1)

(2)

41H (A)42H (B)
43H (C)44H (D)

45H (E)46H (F)
47H (G)48H (H)

45H (E)46H (F)
47H (G)48H (H)
49H (I)4AH (J)
4BH (K)00H

49H (I)4AH (J)
4BH (K)00H

"ABCDEFGHIJK"

"EFGHIJK"

b15 b0∙∙∙ ∙∙∙b7b8
b15 b0∙∙∙ ∙∙∙b7b8(s1)

(s1)+1
(s1)+2
(s1)+3
(s1)+4
(s1)+5

(d)
(d)+1
(d)+2
(d)+3

5
-1

(s2)
(s2)+1

(1)
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Operation examples
Check the operation with an engineering tool.
The following table shows operation conditions.

When outputting a string from the 1st to 3rd characters
 Turn ON "M10."

A string of the 1st to 3rd characters "123" is displayed in "D1035" and later.

When outputting a string from the 2nd to 5th characters
 Turn ON "M11."

A string of the 2nd to 5th characters "2345" is displayed in "D1035" and later.

When outputting a string from the 8th to last characters
 Turn ON "M12."

A string of the 8th to last characters "890" is displayed in "D1035" and later.

Device Description
D5 Location of the first extracted character

D6(D5+1) Number of extracted characters (However, '-1' means the number of characters from the first extracted character to 
last one.)

D1015 Storage location of read result (1234567890 has set)

D1035 Storage location of extracted character string

�

�

�

�

�

�
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REVISIONS
*The manual number is given on the bottom left of the back cover.

Japanese manual number: BCN-P5999-1257-F

 2019 MITSUBISHI ELECTRIC CORPORATION

Revision date *Manual number Description
October 2019 BCN-P5999-1258-A First edition

June 2020 BCN-P5999-1258-B Added or modified parts
Section 6.8, Appendix 11

May 2021 BCN-P5999-1258-C Added or modified parts
Section 1.1, Section 1.2, Section 2.1, Section 4.1, Section 5.2, Section 8.6, Appendix 11

September 2022 BCN-P5999-1258-D Added or modified parts
CONDITIONS OF USE FOR THE PRODUCT, Section 8.1, Section 8.7, Appendix 8, COPYRIGHTS

March 2024 BCN-P5999-1258-E Added or modified parts
SAFETY PRECAUTIONS, Section 5.2, Section 6.9, Section 9.3

This manual confers no industrial property rights or any rights of any other kind, nor does it confer any patent licenses. Mitsubishi Electric Corporation cannot 
be held responsible for any problems involving industrial property rights which may occur as a result of using the contents noted in this manual.
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INFORMATION AND SERVICES
For further information and services, please contact your local Mitsubishi Electric sales office or representative.
Visit our website to find our locations worldwide.

MITSUBISHI ELECTRIC Factory Automation Global Website
Locations Worldwide
www.MitsubishiElectric.com/fa/about-us/overseas/

TRADEMARKS
Microsoft and Windows are trademarks of the Microsoft group of companies.
Cognex and DataMan are registered trademarks of Cognex Corporation.
The company names, system names and product names mentioned in this manual are either registered trademarks or 
trademarks of their respective companies.
In some cases, trademark symbols such as '' or '' are not specified in this manual.

COPYRIGHTS
The screens (screenshots) are used in accordance with the Microsoft Corporation guideline.
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